
C h a p t e r 9
 

Solid Problem Eight 
 

 
In this chapter, you will learn the following to World Class standards: 

 
 Sketch of Solid Problem Eight 
 Starting a 3D part drawing 
 Modifying UCS Settings 
 Constructing a solid perimeter using the Line command 
 Adding circles to the detail 
 Moving a circle inside the perimeter 
 Using the Mirror command to create another circle 
 Using the Offset command to create a new line 
 Using the Arc command to add a circular segment 
 Creating polylines using the Edit Polyline tool 
 Drawing solid boxes 
 Extruding solids from a closed polyline and circles 
 Drawing a solid cylinder 
 Moving solids into position on the master solid 
 Subtracting 3D solids from the master solid 
 Aligning two solids 
 Union of the solids 
 Adding a beveled edge using the Chamfer command 
 Hiding the solid 
 Moving the solid to the origin point 
 Saving the Solid Problem 
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Sketch of Solid Problem Eight 
________________________________________________________ 
 
You will start the eighth solids problem with a rough sketch showing the dimensions of each 
detail. This part is not symmetrical across any axes. In this exercise, you will draw and 
extrude closed polylines that contain the most complex shape of the component and then use 
simple geometric solids to subtract detail.  In problem Eight, the vertical solid contains an arc.  
You will place two circles into that shape.  After extruding the polyline and circles, you will 
subtract the cylinders. You will subtract a solid box and a cylinder from the second master 
solid. You will finish the problem by using the Chamfer tool for the first time in 3D as shown 
in Figure 9.1. 
 

 
Figure 9.1 – Problem Eight Sketch
 
Remember, when you receive a sketch from a professional, quickly identify the different 
shapes and decide begin the drawing. Problem Eight has a number of different details, but you 
should be able to quickly identify and create these details using strategies you have learned so 
far in your 3d training. All of the drills in the Fundamentals of 3D Drawing textbook will 
walk you through such common repetitive maneuvers that you will use often in 3D modeling. 
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Starting a 3D Part Drawing 
________________________________________________________ 
 
You will draw Problem Eight using the Metric template.  First select the New tool on 
the Quick Access Toolbar. A list of templates is loaded in the “Select template” 
window.  Scroll down the list and select Metric.dwt. A new drawing file will open 
that contains the system variables and layer definitions which you will use later in 
Paper Space to finish the drawing. 

 

 

 
 

Figure 9.2 – Starting the drawing using the Metric template 
 
 
 

Modifying UCS Settings 
________________________________________________________ 
 
You may notice the UCS icon moving on the graphical display as you zoom or pan your view.  
If so, the UCS is currently representing the origin (0,0,0) of the drawing area.  This can 
sometimes be distracting, especially if the origin happens to lie in the vicinity of your 
drawing.  You can change the UCS settings so that the icon is always displayed in the bottom 
left-hand corner of the drawing area. Select the Show UCS Icon tool from the Coordinates 
panel under the Home tab (Figure 9.3) and select the “Show UCS Icon” option (Figure 9.4). 
You also have the choice of keeping the UCS displayed at the origin or turning it off 
completely.    
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Figure 9.3  -  The Coordinates panel Figure 9.4  -  Changing the UCS display 
settings 

 
 
 

Constructing a Solid Perimeter Using the Line Command 
________________________________________________________ 
 
First, you need to construct a 3.5 x 2.25 rectangle, so select the Line tool from the 
Draw panel and start the line in the lower right corner of the graphical display.  

 

 

With the Ortho mode “on”, move your cursor 
to the right and type “3.5” and ENTER.  To 
draw the vertical line, move the cursor 
upward and type “2.25” and ENTER.  Drag 
the cursor to the left and type “3.5” and 
ENTER to draw the third line.  To close the 
rectangle, just type “C” and ENTER. Notice 
that you did not draw a Polyline; this is 
because you will need to add some additional 
details before you can edit the completed 
perimeter lines into a polyline. 

  

Figure 9.5 – Drawing a perimeter 
 

 
 
 

Adding Circles to the Detail 
________________________________________________________ 
 
Select the Circle command from the Draw panel.  Select the endpoint Osnap in the 
upper right-hand corner of the rectangle as the center point of the circle.  Type “D” 
and ENTER when the command line prompts you to “specify radius of circle” Then 
type “0.5” and ENTER for the diameter and the circle will appear on the corner as 
shown in Figure 9.7 
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Figure 9.6 – The endpoint Osnap Figure 9.7 – The finished circle 
 
 
 

Moving a Circle Inside the Perimeter 
________________________________________________________ 
 

Next, you need to position the circle at the precise location inside the rectangle. Use 
the Move tool on the Modify panel to accomplish the task.  
 

 

Select the circle when prompted to “Select 
objects”. Pick the circle and the command 
line will respond with “1 found”, so hit 
ENTER to go the second part of the 
command. Next, you need to “specify base 
point or displacement” on the graphical 
display.  Pick your base point anywhere on 
the display. Hit ENTER, and then when 
prompted to select a point of displacement, 
input -01.17,-1.0 which will move the circle a 
negative distance of 1.17 on the X-axis and 
negative 1.0 unit on the Y-axis.  The circle 
will be as shown in Figure 9.8. 

  

Figure 9.8 – Positioning the circle  
  
  
  

Using the Mirror Command to Create Another Circle 
________________________________________________________ 
 
You need to copy the circle over to the left.  You could use the copy command, but 
you can also use the Mirror command.  In this case Osnap points will make using the 
Mirror command easier and faster.   
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Figure 9.9 – Placing the mirror line Figure 9.10 – The copied circle 
 
When prompted to select objects, select the circle and hit ENTER.  Now you need to create a 
mirror line that runs down the exact middle of the rectangle.  Use the midpoint Osnaps of the 
top and bottom sides of the rectangle as the first and second points of the mirror line (Figure 
9.9).  Hit ENTER to accept the default value of “N” for No when prompted to delete the 
source objects.  You should have two circles as shown in Figure 9.10.   
 
 
 

Using the Offset Command to Create a New Line 
________________________________________________________ 
 
You will use the Offset command to create a new line 1.75 units above the bottom line 
of the rectangle without selecting points to define endpoints.  

   

Select the Offset command from the Modify 
panel.  Type 1.75 and ENTER when 
prompted to enter the offset distance.  Next, 
select the bottom horizontal line as the line 
you wish to offset.  After selecting the line, 
pick the direction of movement by selecting 
anywhere above the bottom horizontal line.  
A new line will appear 1.75 above the bottom 
line as shown in Figure 9.11.  Hit ENTER to 
leave the Offset command after placing the 
new line. 

 
Figure 9.11 – The offset line 
 

 
 
 

Using the Arc Command to Add a Circular Segment 
________________________________________________________ 
 
This is the first use of the Arc command in either your 2D or 3D AutoCAD training.  
Before the development of the Fillet command, CAD drafters would use the Arc 
command to make any curves in their drawings. However, in a case such as this the 
Fillet command would not be a very efficient way to create the arc segment. 
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There are many different ways AutoCAD allows you to place an arc.  For now you will use 
one of the least complex techniques called the 3-Point arc.  Select the 3-Point Arc command 
from the Draw panel.   
 

  

Figure 9.12 – The first point of the arc Figure 9.13 – The second point of the arc 
 
As shown in Figure 9.12, pick the endpoint Osnap on the left of the offset line as the first 
point of the arc.  Next, place the second point of the arc by selecting the midpoint Osnap of 
the top side of the rectangle (Figure 9.13).  Now you should see a preview of the arc.  Select 
the endpoint Osnap on the right side of the offset line as shown in Figure 9.14 as the third 
point of the arc.  An arc that intersects all three points will appear inside the rectangle.  Use 
the Erase and Trim tools on the Modify panel to remove the offset, top, left, and right lines so 
the solid looks like the one in Figure 9.16. 
 

  

Figure 9.14 – The third point of the arc Figure 9.15 – The finished arc 
  
  
  

Creating Polylines Using the Edit Polyline Tool 
________________________________________________________ 
 
Use the Edit Polyline tool to merge the three line segments and the arc together into a 
closed polyline.  Select the Edit Polyline tool from the expanded Modify panel and the 
command line will prompt you to “Select polyline or [Multiple]:” 
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Select one of the lines of the perimeter and 
the command line will reply with “Object 
selected is not a polyline Do you want to 
turn it into one? <Y>”.  Type Y and 
ENTER, and then the command line will 
prompt you with a number of editing options 
from which to choose.  Type “J” and 
ENTER to choose the Join option.  The 
command line will prompt you to “Select 
objects” so select all of the lines in the 
perimeter.  The command line should read “4 
total”. Hit ENTER to join all of the entities 
into a closed shape, and then hit ESCAPE to 
exit the Edit Polyline tool. 

  

Figure 9.16 – The closed polyline selected  
 
 
 

Drawing Solid Boxes 
________________________________________________________ 
 
Now you will draw a series of solid boxes; one will become a master solid, while 
another will be subtracted to create a detail.  First select the Southwest Isometric view 
from the View panel so that you will be able to see all three dimensions of the boxes.   
 
Select the Box command from the Modeling panel and select a point to the right of the 2D 
perimeter as the first corner of the box.  Type L after specifying the corner on the graphical 
display to utilize the Length option of the Box command.  Type 3.5 and ENTER as the length 
of the box.  Type 4.75 and ENTER for the width, and 0.75 and ENTER for the height. The 
box will appear as shown in Figure 9.17. 
 
Hit Enter to repeat the Box command and select the bottom left corner of the top face of the 
first box as the first corner of the new box.  Type L after specifying the starting point to use 
the Length option of the Box command.  Select the other corner of the top face of the first box 
3.5 units away to specify the length of the box.  Then enter -0.25 for the both the width and 
the height of the box so that it appears as shown in Figure 9.18.  Remember that if you are 
using Dynamic Input, the position of your cursor will affect the way AutoCAD interoperates 
the values that you enter at the keyboard.   
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Figure 9.17 – The first box Figure 9.18 – The second box 
  
  
  

Extruding a Solid from Closed Polylines and Circles 
________________________________________________________ 
 
Only closed entities like Polylines and Circles can be extruded using this very 
powerful tool on the Modeling panel. You can extrude multiple entities at a time into 
solids with the Extrude command. 
 
Select the Extrude tool on the Modeling panel and the command line will prompt you to 
“select objects”. Select the closed polyline and both circles and the command line will return 
with “3 found”. Hit ENTER to specify the height or path of the solid. Type “0.75” and 
ENTER for the height of the extrusion (Figure 9.19). The three solids will expand into 0.75 
units into the Z axis as shown in Figure 9.20. 
 

  
Figure 9.19 – Entering extrusion height Figure 9.20 – The extruded entities 
  
  
  

Drawing a Solid Cylinder 
________________________________________________________ 
 
You need to add a 1.0 diameter hole in the master solid.  Use the Cylinder command 
to create the feature. 
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Select the Cylinder tool on the Modeling 
panel under the drop-down arrow beneath the 
Box command. Specify the center point for 
the base of the cylinder as the lower right 
corner endpoint Osnap on the first solid box. 
Type “D” for diameter and hit ENTER to 
input the sketch’s measurement of 1.0. Hit 
ENTER to go to the next prompt, which is to 
“specify the height of the cylinder”. Type 
0.75 for the height of the cylinder and hit 
ENTER. The cylinder will appear as shown 
in Figure 9.21. 

  

Figure 9.21 – Adding a solid cylinder  

 
 
 

Moving 3D Solids into Position on the Master Solid 
________________________________________________________ 
 
You need to move two of the solids into position on the master solid.  Select the Move 
command from the modify panel. 
 

  

Figure 9.22 – Moving the box Figure 9.23 – Moving the cylinder 
  
Select the second box as the first object you wish to move.  The command line will respond 
with “1 found” so hit ENTER.  Next, you need to “specify base point or displacement” 
anywhere on the graphical display.  For the “second point of displacement”, type 2.75 while 
orienting the solid box to the left as shown in Figure 9.22. 
 
To move the solid cylinder, hit ENTER to repeat the Move command.  Pick the cylinder and 
the command line will respond with “1 found”, so hit ENTER. Next, you need to “specify 
base point or displacement” anywhere on the graphical display.  For the “second point of 
displacement”, type in the relative coordinate of “@-1.0,1.0” or just “-1,1” if using Dynamic 
Input to move the cylinder as shown in Figure 9.23. 
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Subtracting 3D Solids from the Master Solids 
________________________________________________________ 
 
To remove the cylinders and box from the master solids, select the Subtract tool on the 
Solid Editing panel.   
 

  

Figure 9.24 – Subtracting cylinders from 
left master solid 

Figure 9.25 – Subtracting cylinder and box 
from right master solid 

 
The command line will prompt you to “Select solids and regions to subtract from”. Select 
the master solid on the left and the system will respond with “1 found”.  Hit ENTER to 
proceed to the next step, which is to “Select solids and regions to subtract”. Pick the two 
cylinders inside of the master solid and the command line will respond with “2 found” 
(Figure 9.24).  Hit ENTER and the shape of the two cylinders will disappear from the master 
solid as shown in Figure 9.25.   
 
Hit ENTER to repeat the Subtract command. The command line will prompt you to “Select 
solids and regions to subtract from”. Select the master solid on the right and the system will 
respond with “1 found”.  Hit ENTER to proceed to the next step, which is to “Select solids 
and regions to subtract”. Pick the box and the cylinder and the command line will respond 
with “2 found”.  Hit ENTER and the shape of the two solids will disappear from the master 
solid as shown in Figure 9.25. 
 
 
 

Aligning Two Solids 
________________________________________________________ 
 
Select the Align command by expanding the Modify panel. At the command, “select 
objects”, pick the prism hit ENTER to proceed to the second part of the function. 
Notice that this is not the 3D Align command. 
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The first source and destination points will 
end up becoming the same point in the 
finished alignment.  In this case, select the 
endpoint Osnap of the bottom left corner of 
the left solid as the first source point and then 
the endpoint Osnap of the bottom right corner 
of the back face of the right solid as the first 
destination point.  These two points will join 
to become the same point when the alignment 
is finished.  A temporary line will appear on 
the screen showing the relationship of the two 
points (Figure 9.26).   

  

Figure 9.26 – First alignment points  

  

In this case, the second source and destination 
points will also end up becoming the same 
point in model space.  For the second source 
point, select the bottom right corner of the left 
solid.  Select the back right corner of the right 
master solid as the destination point.  Again a 
temporary line will appear connecting both 
points, showing their relationship in the 
alignment (Figure 9.27).   

  

Figure 9.27 – Second alignment points  

  

 

The third set of points will finalize the 
definition of the planes of the two shapes that 
you are aligning.  Select bottom right corner 
of the top face of the left solid as the third 
source point.  Select the front bottom right 
corner of the right master solid as the third 
destination point (Figure 9.28). Immediately 
the left master solid will snap into alignment 
with the right master solid (Figure 9.29).  
Again, the difficulty of the Align command 
lies not in its complexity as a tool but in 
properly identifying the source and 
destinations points necessary to create the 
desired alignment.   

  

Figure 9.28 – Third alignment points  
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Union of 3D Solids  
________________________________________________________ 
 
With the Union command, you can join one shape or more shapes into a single solid. 
You will use the Union tool to bring the two master solids together.  
 

 

  

Figure 9.29 – The completed alignment Figure 9.30 – The union of the two solids 
 
To combine the two solids, select the Union tool on the Solid Editing panel.  The command 
line will prompt you to “Select objects”. Select both solids and the system will respond with 
“2 found”. Hit ENTER and the solids will become as one entity as shown in Figure 9.30. You 
can see in the graphical display that the overlapping tessellation lines outlining the two solids 
To test your solid, select the entity with one pick of the mouse and the entire solid will 
become dashed. 
 
 
 

Add a Beveled Edge Using the Chamfer Command 
________________________________________________________ 
 
You can use the Chamfer command to add a beveled edge to a corner.  The Chamfer 
command works much like the Fillet command in 3D:  you select the edge rather than 
the two converging lines to define the corner that you wish to Chamfer. Pick the 
Chamfer tool on the Modify panel by clicking on the drop-down arrow next to the 
Fillet tool and selecting the Chamfer command. 
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Select the lower vertical corner on the edge of 
the box. Hit ENTER and then type “1.00” for 
the offset distance. Hit ENTER again and 
type and “1.00” for the second offset 
distance. Hit ENTER and select the vertical 
tessellation line when prompted to “Select 
and Edge or loop”. Hit ENTER once more 
and the 1.0 by 45 degree chamfer will appear 
on the edge of the master solid as shown in 
Figure 9.31. 

  
Figure 9.31 – Placing the beveled edge  

 
 
 

Hiding the 3D Solid 
________________________________________________________ 
 
In Figure 9.31, you will notice that the tessellation lines representing the solid’s 
outline on the far edge of the part are visible. In a real world solid part, you would not 
be able to see through solid unless the material was transparent.  You can use a 
different visual style to see a more realistic view of the part.  
 

Select the Realistic visual style from the 
Visual Style panel under the View tab.  The 
part will appear rendered with a metallic sheen 
as shown in Figure 9.32.  If you wish to return 
the graphical display to the previous visual 
style, choose the visual style called 2D 
Wireframe. Neither command alters the mass 
of the solid or any of the dimensions, but both 
are available for the computer aided designer 
as a viewing option. 

 

Figure 9.32 – The Realistic visual style 
 

  
  

Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Problem Eight to the drawing origin of 0,0,0 on the x, y and z axis, select the Move 
tool from the Modify panel under the Home tab, select the 3D solid, and hit ENTER.  At the 
prompt “specify base point or displacement,” select the bottom left endpoint Osnap as shown 
in Figure 9.33, which will become its insertion point into an assembly drawing.  At the 
“second point of displacement,” type 0,0,0 and ENTER, or #0,0,0 and ENTER if using 
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Dynamic Input. Problem Eight will move to the origin point.  Moving a part at the origin is 
important for when you wish to insert the solid into an External Referenced Assembly 
drawing. 
 

 
Figure 9.33 – Moving the finished solid to the origin 
 
 
 

Saving the Solid Problem 
________________________________________________________ 
 
To save Problem 8 in your Fundamentals of 3D Drawing Folder, select the Save As 
tool on the Quick Access toolbar. The Save Drawing As window will appear in your 
graphical display. In the Save In list box, select your drawing folder.  Type “Problem 
8” in the File Name textbox and hit the Save button to save the drawing (Figure 9.34). 
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Figure 9.34 – Saving Problem Eight 
 
 
 
* World Class CAD Challenge 03-07 * - Close this drawing file.  Create a New file and 
draw the solid using the techniques in this chapter. Move the finished solid to the origin 
of the drawing.  Complete the task in less than 5 minutes.  Continue this drill four times, 
each time completing the drawing in less than 5 minutes to maintain your World Class 
ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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